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11G Dispatch Board 2

Introduction

The 11G Dispatch Board for Dynamics NAV add-on
provides easy and convenient visual management board
added to the Service Management of Dynamics NAV.

Running IIG Dispatch Board from Dynamics NAV

I1G Dispatch Board has been added to the Planning &
Dispatching menu of the Service.

[F-{_1J Conkract Management

-1 Planning & Dispatching
----- == Service Tasks
|._ L Eoard
,__j Reparks
[+ Order Processing
[#-{_ Hiskory
[=-15F Setup
----- f== Default Service Hours
= Work-Hour Templates
== Resource Service Zones
== Report Selections
----- == Service Makt, Setup
,__j General

-

[ -
1| Resource Planning

g Service

:‘ﬂ Human Resources
-
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11G Dispatch Board

Service Order

The Resour ce fields have been added to the Service Order

Header and Line. The Line Resourcefield is required.

&8 90000010 The Cannon Group PLC hhhh - Service Order

General | Invoicing I Shipping I Details | Foreign Trade |

5cooon: o 7!

Contack Mo, .. L L

Motify Customer, . . . .

I 10000 Zi

Service Order Type . . .

ICTDDDDDI i I
Mo b

=0l x|

Customer Information

Custamer ﬁl
= Ship-to Addresses (2}
= Contacts 51
= Service His. ..

Custamer

= Avail, Credit 1]

Mame. . . ... .. .. |The Cannan Garoup PLC Contrack Mo, ... L Iﬁ
Address . .. ... L |192 farket Square Response Date . . . . . lw
Address 20 . 0. L0 | Response Time . . . . IW
Ty v [atlanta A Priority [Low
State [ ZIP Code . . . . [GA | 37724 Status .o [Pending =l
Contact Mame, . . . . . [re. Andy Teal Responsibility Center . . W
Phone Mo. /Phore Mo, 2 . | ﬂ | | Assigned User ID . . . . ﬁ
E-Mail, . ... Ithe \cannon.group. ple@cronuscorp,.. | B Resource . . . . . . . TIMOTHY z
Service L., |Item [N, |Service I...J|Resource | Serial Mo, |Descripti0n |Repair Sooo |War‘
- 4 50002 DESKTOP | TIMOTHY Cornputer IIT 600 MHz INITIAL =
_— 2 50002 DESKTOP | TIMOTHY Cornputer IIT 600 MHz INITIAL
| -
1« | >0
Order - Line vI Functions Posting W Print. .. I Help I

Service Item Information

= Service Ikem, .. ﬁl
= Components 7
= Troubleshaoa.. ()]
= Skilled Resou. .. (1)

= Bar Chart
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11G Dispatch Board 4

11G Dispatch Board

The |1 G Dispatch Board displays active service orders and
service item lines determined by dates and resources.

User specified information for each service order/service
item lineisdisplayed in acell. Eachtype of datain the cell
(e.g., Customer, Service Order Number, Contract Number)
can be color-coded for easier visibility. Also, display names
of data fields can be changed (for example, shortened). The
user can also filter the service orders by requesting only
those service orders with datafalling in certain ranges.

Dispatch Board displays only the Service Orders and
Service Order lines with start date.

=lBlx]

Options  Wiew  About

Alwa-BELEs a2 |

Mark Hanzon I Mary & Dempsey | Test 07 02 I Timathy Sneath I

-
01 a7

Order No. - 50000002

[Customer Ma. - 50000

0200107 f0rder Status - In Process

5 erv.lbem Line No. - 10000
Fepair Status - Service in process

02207
02/0307
Drder Mo, - SO000020 Drder Mo, - 50000071
Customer No. - 10000 Customer Mo. - 10000
020407 |0rder Status - Pending Order Status - Pending
Serv.lbem Line Mo, - 30000 Serv.lbem Line Mo, - 10000
Repair Status - Referred Repair Status - Initial Repair Status

Order Ma. - 50000011

Cugstorner Mo, - 10000

0240507 Order Status - Pending

Serv.Itemn Line Mo, - 20000

Repair Status - Initial Repair Status

Order No. - 50000011
Custorner Mo, - 10000

020607 Order Status - Pending
Serv.ltem Line Mo, - 30000
Fiepair Status - Partly Serviced -
4 [»
Order Mumber  Description Order Date/Time Expected Finish Date
50000002 | [oizoasz001 [17.47 01./08/2001
Order Tupe Order Status Customer Humber Ship Ta Code  Contract Mumber Priarity Cods
[1-InFrocess [50000 [ [ 0-Low
Servltem Line Mo, Fesp. Date Fiezource Code Service [tem Mo, Repair Status
[ 10000 [ o1A0/2000  [MARK | | Service in process
Item Mumber Serial Mumber Starting Date/Time  Ending Date/Time
| 80005 | 02/01/2007 | 10:37 [02/07/2007 10:37
[ [ G CROMUS USA, Inc. | dzroam?

All the columns have equal width, but you can adjust itin a
couple ways. Click anywhere between the names of
Resources at the top of the board, and drag the mouse to the
right to increase the width or to the left to decrease it.
During dragging, a vertical bar displays the new position of
the dragged grid line, and the status bar displays the new

INFORMATION INTEGRATION GROUP 877.475.4092
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11G Dispatch Board

column count.

All the columns will have equal widths when you release
the mouse. The number of columns will remain unchanged
when you resize the window, so you can also adjust cell
width by resizing the entire window. Rows will only have

whole cdlls.

A cell can be dragged to another resource or response date,
and the system will update the corresponding service order.
A tooltip displays the destination date and resource while

dragging.

Options  Wiew  About

A |t g - |t 5| 2

Mark Hanson

| Mary &, Dempsey

Test 07 02

Timothy Sneath |

iyl

0z o7

Q20207

02307

Order No. - 5000000

Custorner Mo. - 50000

Order Status - In Process
Serv.|tem Line Mo. - 10000
Fiepair Status - Service ih process

Order Mo, - 50000020
Custorner Mo, - 10000
020407 |0rder Status - Pending
Serv.|tem Line No. - 30000
Fiepair Status - Refered

Order No. - 50000071

Custorner Mo. - 10000

Order Status - Pending

Serv.|tem Line Mo. - 10000

Fiepair Statug - Initial Repair Status

Order Ma. - 50000011
Customer Mo, - 10000

02/0507 (Order Status - Pending
Serv.Itern Line Mo, - 20000
Repair Status - Initial Repair Status
Order Mo. - 50000011
Custorner Mo, - 10000
0206107 Order Status - Pending
Serv Item Line No. - 30000
FRepair Status - Partly Serviced ha
u Lo
Oider Mumber  Description Order Date/Time  Expected Finish Date
50000002 I m/08/2001 I 1747 01/08/2001
Order Type Order Status Customer Mumber Ship Ta Code  Contract Mumber Priarity Code
[ 1 - In Frocess | En] [ [ 0-Low
Serv/tem Line Mo, Fesp. Date Fiezouice Code Service [tem Mo, Repai Status
[ 10000 [mADs200 [MaRyY | Service in process
Itern Murnber Sernial Murmber Starting Date/Time  Ending Date/Time
[ 50005 02407 /2007 |1U:37 02072007 | 10:37
[ [ G CROMUS USA, Inc. | oz/oas7

The cursor is changed to the “not allowed” sign, if the
move of acell is not allowed (moving without resource or

date change).
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11G Dispatch Board

Cells can be selected using keyboard Arrows, Page Up,
Page Down keys.

Right-clicking on acell (or using the Windows Application
key on the keyboard) displays pop-up menu, from which
you can quickly run some programs for the service order.
To pass focus to the cells part of the screen (for example,
after using Refresh), press Ctrl+G. The left upper cell of the
displayed cells will be selected.

£ Dispatch Board

Options  Wiew  About

A 2hah- [0 Al

Lift for Furniture Linca Martin Mark Hanson Mary & Dempsey |
Order Mo, - SO000018 Order Mo, - 50000070
Customer Ma. - Customer Mo, - 30000
030807 |0rder Status - Pending Order Status - Pending
Serv.ltem Line Mo, -0 Sery e et
Repair Status - HeEair% Mew Order
Order Mo, - 50000019 Cpen Crder
f— Eudstonger Mo, o Ttem Worksheet
rder Statuz - Pending f "
Serv.l_tem Line Mo -0 Dispatches Without Dates
Repair Status - — Print Crder
Dot Print Ttem Line
030907 Order 51 E-mail ko Customer
Serv.lte
——— Repair ¢ Find
034 007
A [
Order Mumber  Description Order Date/Time Expected Finish Date
| 50000010 | | D2/08/2007 [1553 |  02/08/2007
Order Type Order Status Custamer Murnber Ship To Code  Contract Mumber Pricrity Code

| 0- Pending | 30000 | | | 0-Low

Sery.|tem Line Mo, Resp, Date Fegource Code Service ltem Mo, Repair Status

| 80000 | 0241342007 |MARK 10 | Iitial Fiepair Status
Item Murmnber Serial Number Starting Date/Time  Ending D ate/Time

| 80004 | 1390000 |03/08/2007 [10:20 |

| [ ==MOuseR= | CRONUS US4, Inc.

The following options are available from the pop-up menu
for the current service order.

New Order displaysthe quick Service order window
ready for new service order entry.

[ mrar
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11G Dispatch Board

LEE S0000013 - service Order

General |

Mo o 500000 I Y4
Descriphion « .« . . . . . |

Customer Mo, o . Iﬁ
Mame., . . . .. .. .. |

Service Order Twpe . . . Iﬁ
Contrack Mo, . . . . Iﬁ
Contack Mo, . . . . . Iﬁ
Resource . . . . . . .. Im

Docurnent Date . . . . . I 09/23/09
Starting Date . o . . |

Servicel...lltem [, |Resnurce |Serial Mo, |Desu:ri|:utic:n

| Fault &r., .. | Sympka, .. |Faul1

LI []e
w

Crder

vl Line vl Help |

Open order displaysthe Services order window for the
current service order.

Item Worksheet displays the Service item Wor ksheet
window for the current service order.

Print Order printsthe Service Order information to the
default system Printer.

Print Item Line printsthe Service Item Lineinformation
to the default system Printer.

E-mail to Customer e-mailsthe Order information to the
Customer.

Dispatches Without Dates opens alist of Service Orders
and Service Order Lines without start dates. Clicking the
Select button changes its start date to the date from which
the cell had been selected.
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11G Dispatch Board

£ Dispatches Without Dates List

X
rder Mo, Sery. ltem Li... | Resource ... | Besource Mame Repair Status Order [ ate
tark Hanson
50000010 MARE. bark Hanzon IMITIAL 20842007
50000013 MARE. bark Hanzon IMITIAL 202642007
50000015 MARE. bark Hanzon 202642007
[~ Show Al Select | Cancel |
|5 Rows. | =eNOUSER™ | CRONUS US&, Inc. | 0341107
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11G Dispatch Board

The main menu located in the upper left corner of the
Dispatch Board screen, contains the following submenus.

e b Haraon i WMoy &, Donpaey Tesk 07 02 |  Tenativy Sreass E

]
et Statun - In Procen

e e Lirs Wi - $0000
Slahut - Senace n

E
i

e S

3

i*ﬁ

Ih
i -
Lires
Shahus -

EiN

L

L o [ R
1 Dt Sl Cuitiis Mufres ToCode Corieset Husbes v
&
e e e G e
| Gore lhwen Ly Mo Flosp (Dot Flesass Code 5mll|-h Fosgomn Slmhun
[0 [zt [y Ii-mnmal
Mars Hunges Gonal Munbar ﬂ-ﬂﬂm E
[ I hl] |33-?

| I CRONUS USA e

In the Options menu, you can select an existing Option
Type, and Edit Optionsin the Optionsfor User dialog
box (described later). Currently active Option Typeis
indicated with a checkmark.
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11G Dispatch Board 10

£ Dispat ch Board S IES
Test 07 02 i Tamatiey S =
=
~ SRR
10000
e - Boon
© Irshisl Fleps Stafus
Khambio SoOROTT
Wumtomes . - 10000
T [0vter S - Proruing
[derw itern Lrw Mo - 0000
Flepos Soon - Pty Servoed
Hiz: - SX0G0040 Hlax - SO000G40 Ho - SO0 —
it Mo - 10000 Mo, - 10000 Mo - 20000
o L Py 000 ""'P*'.“J.:En hem L e -1
| J - ke & A i !
Ne.-1 He -
nher Stabuz S -
L 23000 T
Giaha - bl Sish Siuhih . Irakal e Shafis
7T
-
A I+~
[esder Humbes Data/Tierm _ E FrehDan|
i L e
nﬂul Cutlores Muries ToCode Conssct Nunbes -
I l1 InPral:' ] I ] 0 Lowe
Sawrw ers L Mo Flagp Dhale Sorvce Bam Ho Fosgomn Slmhun
WEET [TALZm iu.nn: | [ S i proces
[ern Munger Gendl Munber '“"‘Tml Dt Timen
[ I [Tl BT I.'.l.i'-’il?-' LT
| | [ CRONUS U5A ke [T

In the View menu, you can select to Show/Hide Toolbar,
Grid Lines, Fields, Blanks (blank rows and columns),
Blocked Resour ces, Refresh the Dispatch Board view, and
Find a specific Service order/Serviceitem line on the
Board.

The Toolbar enables you to quickly Exit the Dispatch
Board, Refresh the view, Edit Options, select Option
Type, Show/Hide Grid Lines, Fields, Blanks, Blocked
Resour ces, Find Service order/Service item line. Current
Option Typeisunavailable (already selected).

The Dispatch Board is automatically refreshed when
Accepting changes in the Service order screen, deleting
service orderg/service item lines, creating new service
orders/service item lines.

INFORMATION INTEGRATION GROUP 877.475.4092
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11G Dispatch Board 11

To control which data fields appear in the cells (and their
colors), select the Edit Options submenu from the Options
menu of the Dispatch Board main window.

Click the Fields tab in the displayed Options for User

dialog box.
x]
Options Type IEIEIEI TI Description IStandard
Filters | Fields | View
¥ Show IEIrderNumI:uer j @ ':ﬁ
¥ Show IEustDmerNumber j @ ':ﬁ
¥ Show IDrderStatus j @ ':§
— m i & Number j @ l:ﬁ
Liztormer Mo, = a
RN

Ml Past Due Orders l:ﬁ

Ok | Cancel

| | G | CRONUS USA Inc. | 01418407

Y ou can choose up to five data fields to be displayed in the
cells of the board. Select fields from the drop-down lists,
and see preview on the | eft.

You can hide fields if you do not need all five fields
displayed. Uncheck the boxes next to fields that you do not
want to be displayed.

Y ou can aso change the display name of selected fields.
Click the Edit button next to the field drop-down. An edit
box is displayed, where you can type a shorter or more
convenient name for the field. (Y ou can even delete the
entire name. If you have highlighted the field with color,
you can identify it that way or, simply remember which one
itis)

Click the Default button to reset the name to the default.
Click OK to save the new display name.

INFORMATION INTEGRATION GROUP 877.475.4092
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12

The Past Due Or der s shows the technicians whose due
dates are expired but the status is not set on Close.

To change the color of afield, click its Color button.
Select color in the standard Windows Color dialog box.

Basic caolors:

T TN
C_ AR )
Al | Bl |
EMEEEEEN
AN EEEEEN

Custorn colors:

[T
Hug:lﬁ Eed:l[l—
.--..... ﬁat:lﬂ— ﬁreen:lﬂ—

Define Custarn Calors >3 | Lolorf3olid oy IEI Elue: IEI

k. I Cancel | Add to Cusgtom Colors

1

2l x|

INFORMATION INTEGRATION GROUP
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11G Dispatch Board 13

In the Filter s tab of the Optionsfor User screen, you may
request to see only the service orders meeting certain
criteria.

To set arange of orders (or just one order), click the Order

Number line.
x
Options Type IEIEIEI TI Description IStandard
Filters T Fieldz T Wit ]
Field Mame All Starting E nding
[Order Number I~ |s0000001 Q) [soo00008 Qo ||
Fields | Starting | E nding -
Date 014011900 12/31/2099
Fiesource Mumber
[ Order Mumber SO0o00o001 SO0o0000s
Cuztomer Mumber |-
Crder Status [ - Pending 3-OnHold
Order Type
Order Pricrity - Liow 2 - High
FAClim T mad- s LI
[T Show Unchecked Lines Orly
Cancel |
| | G | CRONUS USA Inc. | 01418407

Enter the Starting and Ending Order Number and click
the Save Change icon to the right of the Ending lookup.

To undo the range selection, check the All box. This means
that all possible values of the field will be displayed on the
board.

Repeat the process to select arange of datafor any other
fields you may wish to limit. Use the OK button when you
are done.

Check the Show Unchecked Lines Only box to display
only lines with limitations of range.

INFORMATION INTEGRATION GROUP 877.475.4092
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14

Go to the View tab in the Optionsfor User screen.

£ Dptions for User - "TIG"

Options Type IEIEIEI vI Description IStandard

Fiters | Fields | View
— Show on Startup — _
¥ Toobar ¥ Filds Show as Columin ITec:hnu:lan j &+ Duplicate
¥ Giid Lines I Blanks Show as Bow IDate j " Duplicate
¥ EBlocked Resouwces
— Wiew Date Range Usze colar for Tasks in Colar Bars v
Number Of Days Before Current Date I':' Use color for Dispatches in Color Bars W
MNurnber OF Days After Current Date ||:| Shaw Colar Bars Dwer Test '
Date/Time Fange I
— Time
Open Time I 9:00:00 A j Cloze Time I 7:00:00 PM j Interyval |1 b 'I

Cancel |

| | IIG | CROMUS USA, Inc.

| 01A8a07

Check the corresponding boxes in the Show on Startup
section to show Toolbar, Grid Lines, Fields, Blanks,
Blocked Resour ces each time the Dispatch Board starts.

Y ou can set the Numbers Of Days Before and After
Current Date. This can be useful to locate service orders
more easily and also to shorten refresh time of the Board. If
both are set to 0, all the Dates are displayed.

The Show as Column and Show as Row combo boxes
have been added to the Optionsfor Usersform. The
position of the Technician is determined by those options,
whether to show in a column or in arow.

The Use Color for Tasksin Color Bars, Use Color for
Dispatchesin Color Bars, Show Color Bars Over Text,
Date/Time Range check boxes have been added to the
Optionsfor Usersform. If the Date/Time Range option is
checked, the whole time (from Start Time to End Time) is
specified on the Dispatch Board. If no End Date is specified
for the technician, then the line will last till the end of the
Dispatch.

INFORMATION INTEGRATION GROUP
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11G Dispatch Board 15

The Time group (Open Time, Close Time, Interval) has
been added to the Options for Usersform. Thisoptionis
intended for displaying the day with hours.

By default, the displayed fields, names, ranges and colors
are saved for each user and each company separately under
Option Type 000 Standard.

Y ou can create different views by entering a new Option
Type and corresponding Description. The settings are reset
to defaults in the program. Make your changes, and click
OK to save the Option Type. When you open the Options
dialog box again, the new Option Type is added to the
drop-down list and can be selected for editing.

INFORMATION INTEGRATION GROUP 877.475.4092
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11G Dispatch Board 16

Status Setup

The Color column has been added to the Order Status
Setup menu item of the Order Processing Setup menu.

=

Service Order Sta. .. | Priority Colar |
Pending Medium High (I k|
In Process High T
Finished Lo (T

b | On Hold Medium Lows T

[
Help |

The Color column has been added to the Repair Status
Setup menu item of the Order Processing Setup menu.

EE Repair Status Setup -0l x|

Code |Descriptiun |S |F'riDrit\,-' Color Initial |In Process |Finished |
|| GTERER  Service is Finished Fi... Low v
J— INPROC,,, |Service in process I... High i W
| |IMITIAL  Initial Repair Status P... Medo,,, | i v
| |PARTLYS... Partly Serviced P... Mediy,., | o
| |QUOTEFIN | GQuatation Finished Q... Mediu...

REFERRED  Referred P... |Mediy,.. | "
| |SPORDE... Spare Part ordered ... Mediy,.. | M
|___|SPRCYD  Spare part received P... |Mediy, .. |
| |WAITCUST  Waiting For Custamer Do Mediy,,, | —i

-
L | o

Help |

Set colorsin the fields in order to distinguish the statuses of
technicians in the Dispatch Board.

INFORMATION INTEGRATION GROUP 877.475.4092
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The Board will look like this after setting colors:

i8]
Options  Yiew  About
Aol |
Linda hartin Mark Hanson | Mary A. Dempsey I Test 07.02 I
a
o7
Order Mo. - SO00000;
Customer No. - 50000
02 a7 (Order Status - In Process
Serv.Item Line Mo, - 10000
Repair Status - Service in process
020207
02mz07

Order No. - 500000711

Custorner Mo, - 10000

Order Status - Pending

Serv.lbem Line No. - 40000

FHepair Status - Initial Repair Status

021407

Order No. - SO000020
Customner Mo. - 10000
Order Status - Pending
Serv lkem Line Mo, - 30000
Repair Status - Aefened

Order Na. - 50000011

Custorner Mo, - 10000

Order Status - Pending

Serv.Itermn Line Mo, - 10000

Repair Status - Initial Repair Status

Order No. - 50000011
Custorner Mo, - 10000

020507 Order Status - Pending
Serv Item Line No. - 20000
Fiepair Status - Initisl Repair Status
02me07
A

Order Mumber  Description

50000002 |

Order Type Order Status
| 1-In Process

Custamer Humber Ship To Code
I 50000

Order Date/Time  Expected Finish Date
[oi/0as2001 [17.47 01,/08/2001
Contract Mumber Pricrity Code

I 0-Low

Serv.ltem Line Mo, Resp. Date Resource Code Semvice [tem Mo, Repair Status

[ 10000 fo1/i0/2000  [MARY | Service in process

Itern Murmber Serial Murnber Starting Date/Time  Ending DatedTime

| 50005 | 02/01/2007 [10:37 [02/07/2007 [10.37
[ I G CROMUS USA, Inc. [ 20807
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